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Workbook Exercises for WHEAT EMAP Programs
Gregory W. Pouch

Abstract
This manual describes a series of exercises to demonstrate various features of

WmAT electronic mapping programs a]MAp programs).  It is laid out as a tutorial and
demonstrates many features of the various WREAT programs.  At the end of this tutorial,
you should be able to design and use electronic maps with WREAT, using existing
geographic databases.
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Introduction

Overview
This workbook explains how to use EMAP3STD and EMAP3LIT.  EMAP3STD and

EMAP3LIT, are virtually identical except that EMAp3STD allows the user to define themes
and EMAP3LIT can only use themes that have definitions stored in a database or can be
copied there from another program, such as TIIMDFEDT.

This workbook contains step-by-step instructions for common tasks in WREAT
EMAP, including opening databases and themes, designing themes, performing spatial
queries, and copying data to other applications.
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The specific examples are for use with the KC_DCW.MDB database, but illustrate
the general idea of how to perform each task. (KC_DCW.MDB is a database of the
Kansas City area based on the US Defense Mapping Agency's Digital Chart of the
World.)

Before you get started
To perform these exercises, you should be at a computer with WHEAT already

installed and a copy of the sample database KC_DCW.MDB on the hard disk, preferably
in the same directory as WHEAT or in a sub-directory of WREAT.

This manual assumes the user is familiar with the Microsoft Windows interface and
knows how to perform such tasks as selecting menu items and choosing options.  In
addition, it assumes a basic finiliarity with database concepts.

Ideally, you should have a copy of MSAccess 2.0 available.  If you don't have
Access available, you might want to download the unsupported database utilities, or use
the WREAT-Excel add-in to convert data back and forth.  (I hope to release a version of
WlmAT that can use 32-bit Access (95/97...?) databases, but this hasn't been funded as of
this writing.)

Some definitions
A database contains data about a particular topic or set of topics, as defined by

the user/owner/designer of the database.  In a database, data is stored in tables, and can be
retrieved from tables or queries (virtual tables).  (There can also be variety of other things
like forms, reports, and programs stored in a database, as well.)

Tables are organized sets of information containing records, one for each
individual thing in the database.  A record is composed of fields, which are attributes that
describe the thing.  Thus, a table concerning schools might have records for each school in
a county, and the records might include the name (as text), date founded (as date),
operating budget (as a floating point number), date closed (as date), number of buses
owned (as integer number), principal' s nane (as text), and number of pupils (as integer
number).  Usually, a database table is shown as a table, where each record is a row and
each field is a column.  Some of the fields listed, such as date closed and number of buses,
will not occur for each individual school.  In these cases, a relational database stores a
null, indicating that no information is available.

While a relational database stores information in tables, it can rcfrz.eve information
as virtual tables called queries.  A query is the answer to a question asked about the
datatable, such as:  "show all schools with an operating budget above $500,000".  A query
can return data from several related tables by joining them.  For example, suppose we had
another table containing infomation about students.  It might contain student's nane, age,
address, and name of school attended.  We could then find out who a student's principal is
by designing a query which relates the school name field in the student table to the name
field in the school table.  Queries are generally used for combining information from
several tables, selecting subsets of records, or selecting subsets of fields.  By allowing data
to be stored in a single lceation (such as the principal's name in the school field) and
related at a later time, relational databases can reduce storage requirements, and allow the
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updating of data to be considerably easier than if each record contained all data that might
ever be needed.

WmAT uses the word theme to describe two slightly different concepts.  Most
specifically, a theme is a set of features to be shown on the map:  it includes the
geographic location(s) of the feature, the plot style, and a serial number used for querying.
Theme is also used to describe the instructions for assembling this data (specifically, an
SQL statement containing a query indicating what data to plot and how).  All data in a
theme comes from one table or query.

Typographic Conventions
Text on the computer screen is usually shown in this font: Text on a button.
Selecting the File menu, and the Open Theme... menu item within the file menu

will be denoted as "Select the menu item File+»Open Theme..."

Lesson 1  Getting Started
Lesson 1 will show you how to open a database, load pre-defined themes and

layers, perform a spatial query, and copy the results to a spreadsheet for further analysis.

1) Start EMAP (EMAP3STD or EMAP3IJT, preferably EMAP3STD) by double-clicking on
its icon in Program Manager.

This will start EMAP and the main window will contain at least two windows.  The
window you will spend most of your time in is the Mapview window (you can open
several of these at once).  The other window that appears at startup is the
Mapcabinet, which you use to open databases and manipulate themes.  When you
first start EMAP, it automatically gees to the Mapcabinet and opens the file menu.
You should select Open Database... or choose a previously-opened database from the
list of recently-used files.

2) Open the KC_DCW.MDB database.  (Under Windows95 and Windows NT, extensions
nright not be visible.)

As soon as you open a database, EMAp automatically brings up a dialog box
asking what themes you want to load.
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3) Load the themes StatespolygonsQDF, BordersLinesQDF and TownspolygonsQDF.
I.hi.uS_...vy_i..I.I givg`.~„a stai8 in_ap yith major urban ar8a§ shown..

Statespolygon$ODF
BordersLinesBDF

SYMBOLS  Townspoints
LABE LS  Townspointst] DF
DiainagepolygtJnsQDF
DrainaggLingsoDF
DiainageTe*toDF
LandcovBipolgrgonsaDF
ElevationLinesoDF
5YM B0 LS  Elevationpointsq DF
LABE LS  Elevationpointso DF
SYMB0 LS Land[overpointst]DF  Mines
F]ailroadsQ DF   PuipleD asked
Boad$ODF
Tian§poilationstiucturesLinesoDF  Bridgechnd
SYMB0 LS Tiansportationst[uctuiespointso DF
UtilitiesLinesQDF
*CultuialFeatuiesLines H) ams] D aikpu[ple
5YM B0LS AirF]ortsQDF
LABELSAiipoitsoDF
All contouis Elevatiens contoured from Ail

§ta(espc)I onsoDF

TownspolygonsQDF   50lidpink  NoOu[line

If you haven't seen this style of dialog, you need to learn how to use it, as they are
quite common.  The list on the left contains a set of possible items.  The list on the
right contains your selections.  To copy an item from Available to the Chosen list,
you can either click on the item in the list at left, then click on the > button;  or
double-click on the desired item in the list at left.  This will add them to the list at
right.  To remove an item from the list at right, double-click on it or click on it and
click on < .

If nothing is highlighted at right, items will be added to the end of the list.  If
something is highlighted, new items will be inserted before it. (You can un-highlight
something with the EScape key.) You can move an item up or down in the list at
right by selecting and clicking on the Up and Down buttons or arrows.  EMAP will
load the item listed at top first and work its way down the list.

When you click OK, the themes listed at right will be loaded.  You can also choose
Cancel to not perform the action.  The options at the bottom control what themes or
features to load.  You can load all data specified in a theme, or only the data that lies
in the rectangle specified in the box at the bottom.
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4) After choosing to load the themes, select one of the themes in the Mapcabinet to see
more information about the theme.

You use the map cabinet to load pre-defined themes, unload themes, and open and
close databases, among other things.  In the standard edition, you can also define themes.

5)   Load a layer of data.  Go to the Mapcabinet and choose the Open button to load pre-
defined themes.  Select the option button for Layers at the upper left.  This will cause
the upper-left dropdown list to be filled with a list of available layers.  Select Drainage,
then click on the >> button to add all of them to the list.  Click on OK to load them.

A layer is an ordered list of themes.  By using layers, you can load a group of
themes in a particular order.  A topic is an un-ordered group of themes, which you
can use to organize related themes that you don't want to plot in any particular
order.
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6) Go to the Mapview window and have a look at the map so far.  If the map is blank,

7) Zoom in on the Kansas City area by selecting Zoom as the Mouse Use  (upper-left part
of the Mapview window) and drag a rectangle around the area containing the rivers.
(This is the main area of the database.)

8) Go to the file menu and select File-»Open Theme...  Load the theme "AixportsQDF
Symbols".  Note that the view shifted to include all features loaded so far.  Go the View
menu and select Previous View to re-set the view area.
Go to the Options page of the Mapview window and de-select "Automatically expand view
area to include new themes"  Load the theme "AiaportsQDF Labels".  Note that the view
area doesn't shift this time.

9) Go to the Search page of the Mapview Window.  From the list, select the theme
"AirportsQDF Symbols".  Choose the option to Run Query (at the top under Action to take

on a double click)  and select Closest Point for the Type of Spatial Search   .
Go back to the Map page and double-click somewhere.  Note that the symbol closest to
where you double-clicked is bold and a different color, and there is a marker showing
where you clicked.  Go back to the Search page and notice that you can now see the
search results in the text box.  Copy the text to a spreadsheet, and notice that it's laid out
as spreadsheet data.
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10) Go back to EMAP and go to the Map page.  From the Edit menu, select Copy Map to
the Clipboard.  Wait until you hear a beep, indicating that the clipboard now contains a
copy of the map.  Go back to the spreadsheet.  Choose Edit Paste Special  and choose
Picture for the format. You now have a copy of the map in the spreadsheet along with the
data retrieved for the spatial query.

11) Go back to EMAp and go to the Searoh page.  In the frame for Action to take on double-
click, check the box for Open Editor.  Change the Type of Spatial Query to All within radius
and set the radius to 32000 (in this case, meters   or 20 miles).  Go to the Map page and
double-click.  This will bring up a spreadsheet-like window containing Spatial Query
Results.  Using this window, you can see the same infomation as on the Search page of
Mapview, but you can also edit it.  If you edit something here, your database is
automatically updated:  TIIERE IS NO  UN-DO! ! !  You can bring up a similar window to
view or edit a table by choosing Tools-»Database Viewer;  there, you choose the table or
query and can apply a filter to the data.
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Lesson 2  Adjusting the Map
This lesson explains how to control what area you look at with a Mapview window and
how to control the appearance of the map.  Try things: the very worst that can happen is
your computer might lock up and need to be re-booted.

1)  If you closed EMAP down after completing lesson 1, start it up, open the database, and
load some themes.
2)  Go to the options page.  Play with these options and view the results until you're ready
to move on.
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This page lets you set a variety of options, including whether to load all features orjust
those inside a rectangle, whether to have bitmap copy of the current map instead of re-
drawing each time (slower to re-draw the first time, but if you're seeing a lot of re-draws,
it might be faster overall), whether to show a scale bar, whether to show a graticule (map
coordinate grid), the map background color, the window' s caption,
3) Play with the following items on the View menu:    Zoom ln, Zoom Out, Zoom all the way
out, Shift F3ight, Shift Left, Shift Up, Shift Down.   The menu gives keyboard shortcuts for
these items.  Notice not only what this does to the view, but also the scroll bars.
View-»Zoom Step Size controls how big zoom and shift steps are:  it does not move the
view rectangle.

4)  Choose the menu item View-»Specify View Pegion... which will display the

Play with this window for a while.  Select a stored view.  Store a view.  Drag the sizing
boxes, and notice that the text boxes above change to reflect those changes.  Change the
text in one of the text boxes, hit Enter, and notice that the view rectangle box changes
size.
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If you cancel, the view rectangle in the Mapview remains the same.  If you click OK, the
view rectangle is set from here.  The view area that results will be this rectangle plus a
border zone to make it fit the screen.

5)  Choose the menu-item Tools-»Themes Visible...  Un-check some themes, click OK, and
notice that the themes are not shown, although they are still loaded.

6) Choose the menu-item Tools-»Themes Order...  Move some themes up or down in the
plot order using the Up and Down buttons or arrows.
If you remove a theme using the < button, it is no longer in the themes visible list for this
Mapview;  you can add it back later using the > button.  All themes in the Mapview
subset of themes are visible after re-ordering themes.

Lesson 3 Themes
This lesson will show you how to design a theme, load and un-load themes, and perfom a
number of other operations on themes.

1) Start EMAP and open the database.  If you `re not in the Mapcabinet window, go
there.

2) Choose the menu-item File-»New Theme-»Symbols...

3) From the dropdown list labeled Table or Query  , choose Airports Points.
All the other list boxes are filled with fields from this table/query and constants.

EMAP will guesses at what fields to use for what.  You get to choose the
table/query, where the coordinates come from, the serial number (unique number)
used for spatial queries. and the plot style.  You can set the title for this theme by
entering it in the text box.

4) Design the theme.
EMAP needs to know what data to plot and how.  You decide this.  You have

already selected the source (table or query), and EMAP has guessed that
Coordinate_X_ and Coordinate_Y_ contain the X and Y coordinates respectively,
and has already chosen defaults for plot style.

Each aspect of the theme definition is under your control.  Coordinates have to
come from a field (lines and polygons) or fields (point, text, tile) in the database.
Other parts of the feature description can be based on a field or constant.  (e.g., you
could use a field named ITontsize] to set the font size of the symbols if you had
entered sizes for each airport, or you could have all symbols in a theme be 12 point
by using 12 for the value of size.)

For most aspects of a theme definition, EMAP provides a dropdown list, usually
containing constants and fields as appropriate.  You can select any of these field
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names or constants, manually enter a constant, copy a constant from the clipboard,
or drag a field mane and drop it on the list or the adjacent label or button.

When a button is adjacent to a dropdown list, you can click on it and bring up a
window that lets you set the style.  To drag a field name from the list of available
fields, select the field and click on the Drag Field button.  You can copy a field name
by clicking on it and copy/paste using standard keyboard shortcuts.

You can also set criteria to limit the features loaded based on field values (e.g.,
you could load only airports with an elevation below loco feet by entering
[AEPTVAL] <1000 in the criteria box  [1 happen to know that  [AEPTVAL] is the
airport elevation in feet.  Generally, you need to know what's in the fields of a table
or query to use it, and this one has oddly cryptic names.])  You would do this by
finding the field of interest and dragging or copying it to the criteria box and enter
whatever else (the <1000)was needed to complete the criteria.  (Criteria use SQL
syntax)

Back to the main story line.  You've already selected the table Airports and EMAP
automatically selected default fields and constants.

Click on the symbol button and choose to bring up the Symbol selection window.
If "Wheat Point Symbols 3" is not the font listed in the dropdown, choose it.  Pick a
symbol from the grid (maybe one of the airplane symbols?).  Click on OK.  (If the
right symbol is not shown in the sample box, click on the font list and select the font
again.  The red box labeled Font Code should have a number showing.)

Click on the button Color, and choose some color that you're sure isn't already on
the map, like orange or dark green.  Click OK, and notice the sample.

Set the font size to 15 (or whatever).  You can choose from the list or enter the
font size manually.  If you use too small a size for symbol fonts, the results are
unpredictable.

We're going to accept EMAP' s guesses at coordinates and the serial number field.
Add the criteria [AEPTVAL] <10cO.  Change the theme title to "Airports below
lcoo ft" and click OK.

5) Go to Mapcabinet, select the theme you just created, and Save it.  This saves the theme
definition to the database so you can later load it.

6) Un-load the theme by clicking on the Unload button.

7) Open the theme you just unloaded.  Select it and notice the theme information
displayed.

8) Go to the Mapview window and zoom in on some small area that contains a few
airports.  Go to the Options page and set it to Limit Load  to the current view rectangle.

9) Go back to the Mapcabinet, select the new airports theme, and Pleload it.  Select it
again, and notice that fewer features are loaded.  This happened because you're only
loading features within the current load-bounds rectangle.  (For point and text themes, this
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applies strictly.  For lines and polygons, if the bounding rectangle of the feature overlaps
the load-bounds, the feature gets loaded.

10) Go to Mapview and perform a spatial query on the theme, setting it to Open Editor
when you perform a spatial query.  Redraw the map and notice that the features found by
the spatial query are highlighted.   Alter the elevation to be above 1000 ft (change the
column AEPTVAL).  Pay close attention to where that airport is, because it will vanish in
the next step.

11) Go to the Mapcabinet and Reload the theme, then go to Mapview.  When it redraws,
notice that the airport whose elevation you just set is no longer there.  (The record is still
there, but this theme excluded it because of the elevation.)

12) Perform a spatial query to select another airport.  Go to Mapcabinet, and
Clear Highlights.  Go back to Mapview and notice that the airport is no longer highlighted.
Perfomi another spatial query, go to the Search page, and copy the zqFeaturelD value (the
serial number).  Go back to the map page and perform another spatial query.  Redraw the
map.  Go the Mapcabinet and Highlight by Serial Number and paste the serial number to
the list.  Redraw the map again..  This time, all the features whose serial numbers were
selected in Highlight by Serial Number are highlighted.  Although this example was not
terribly useful, you could use this technique to select a subset of features using their
attributes in Access and highlight them in EMAp using their serial numbers.

13) If you're familiar with databases, this might be interesting:  theme definitions in
WHEAT are SQL statements.  You can manually edit these, and you can see them in the
lower part of the Mapcabinet or on a theme definition fomi on the right.

Lesson 4 Layers
Layers are ordered groups of themes, usually related to each other.  Topics are un-ordered
sets of themes.  You can use either or both to help you organize themes, and you can use
layers to load a set of themes quickly.

1) Start to load some themes, either from Mapcabinet or Mapview.  Click on the Layers
button.

2) Select {All} from the list on the left, which brings up a list of all themes definitions
stored in the database.

3) Add the following themes to the list on the left: "Townspolygons QDF Solidpink
Nooutline",  "TownsQDF Symbols", and "TownsQDF Labels".

4)  In the dropdown list box on the left, enter a name for this layer like "Urban Areas"
then click on the Save button.
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5) Click on Cancel, then choose to load themes again, then choose layers again.  The
Miscellaneous Transportation layer is now in the list of themes.  Click on the >> button to
load all the features in that order, then click on OK to load them.

6) Start to load some themes from layers again, but this time, choose Urban Areas in the
dropdown list at right.  Move one of the themes up in the list, then click on Save.  Choose
the layer in the dropdown on the left, and notice that the order has changed.

7) Deleting is as important as adding.  Choose the Urban Areas layer in the right list and
select a theme.  Hit the Delete key or choose File-»Delete  and that theme is deleted from
that list.  To save the modified layer, click on the Save button.  Put the cursor in the right
dropdown list above the theme list and choose File-»Delete  and the layer will be deleted.
(If you somehow end up with blanks in a layer list, the easy solution is to select and delete
each blank, then save the layer.)

8) Topics work a lot like themes, but without the ordering aspect.
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The Kansas  Geological Survey does  not guarantee this  document to be  free from
errors    or    inaccuracies    and    disclaims    any    responsibility    or    liability    for
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